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XP ObjecAves	
  

• 
• 
• 
• 

Change fonts, font style, and font color	
  
Add fill colors and a background image	
  

Create formulas to calculate sales data	
  
Apply Currency and Accoun:ng formats and	
  

	
   	
  the Percent style	
  
	
  •  Format dates and :mes	
  

	
  •  Align, indent, and rotate cell contents	
  
	
  •  Merge a group of cells	
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XP ObjecAves	
  
•  Use the AVERAGE func:on	
  
•  Apply cell styles	
  
•  Copy and paste formats with the Format	
  

	
  Painter	
  
•  Find and replace text and formaEng	
  

•  Change workbook themes	
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XP ObjecAves	
  

•  Highlight cells with condi:onal formats	
  
•  Format a worksheet for prin:ng	
  
•  Set the print area, insert page breaks, add	
  

	
  print :tles, create headers and footers, and set	
  
	
  margins	
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XP Visual Overview	
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XP Worksheet Forma4ng	
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XP Forma4ng Cell Text	
  

	
  •   Forma4ng	
  
	
   	
  – Process of changing workbook’s appearance by	
  
	
   	
   	
  defining fonts, styles, colors, and graphical effects	
  
	
   	
   	
   	
  • Only the appearance of data changes, not data	
  
	
   	
   	
   	
   	
  itself	
  

	
   	
  – Enhances readability and appeal	
  
	
   	
  – Live Preview shows the effects of formaEng	
  
	
   	
   	
  op:ons before you apply them	
  

	
  •   Themes	
  

	
   	
  – Named collec:ons of formaEng effects	
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XP Forma4ng Cell Text	
  
•  You can add formaEng to a workbook by	
  

	
  choosing its fonts, styles, colors, and	
  
	
  decora:ve features through the use of	
  
	
  themes.	
  
	
   	
  – A theme is a collec:on of formaEng for text,	
  
	
   	
   	
  colors, and graphical effects that are applied	
  
	
   	
   	
  throughout a workbook to create a specific look	
  
	
   	
   	
  and feel.	
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XP Forma4ng Cell Text	
  

	
  •  As you format a workbook, Galleries and Live	
  
	
   	
  Preview show how a workbook would be	
  
	
   	
  affected by a formaEng selec:on.	
  
	
   	
   	
  – A Gallery is a menu that shows a visual	
  
	
   	
   	
   	
  representa:on of the op:ons available for the	
  
	
   	
   	
   	
  selected buPon.	
  
	
   	
   	
  – Live Preview shows the results of clicking each	
  
	
   	
   	
   	
  op:on. By poin:ng to different op:ons, you can	
  
	
   	
   	
   	
  quickly see different results before selec:ng the	
  
	
   	
   	
   	
  format you want.	
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XP Applying Fonts and Font Styles	
  
•  Theme fonts and non-­‐theme fonts	
  
•  Character styles (serif fonts and	
  

	
  sans serif fonts)	
  
•  Font styles, special effects, font size	
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XP Applying a Font Color	
  
•  Themes have 12 colors: 4 for text and	
  

	
  backgrounds, 6 for accents and highlights, and	
  
	
  2 for hyperlinks	
  

•  Standard colors (always available)	
  
•  Custom colors	
  
•  Automa:c colors	
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XP Working with Colors and Backgrounds	
  
•  Changing a fill color	
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XP Working with Colors and Backgrounds	
  
•  Background images do not print	
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XP Changing a Fill Color	
  
•  Select the range you wish to apply a fill color	
  

	
  to	
  
•  On the Home tab, in the Font group, click the	
  

	
  Fill Color buPon arrow, and then click the	
  
	
  specific color you wish to use in the Standard	
  
	
  Colors sec:on.	
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XP Adding a Background Image	
  

	
  •  On the ribbon, click the Page Layout tab to	
  
	
   	
  display the page layout op:ons.	
  
	
  •  In the Page Setup group, click the Background	
  
	
   	
  buPon.	
  
	
  •  Click the Browse buPon. The Sheet	
  
	
   	
  Background dialog box opens allowing you to	
  
	
   	
  navigate to the file loca:on	
  
	
  •  Click the file, and then click Insert. The image	
  
	
   	
  is added to the background	
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XP Using FuncAons and Formulas	
  
•  A primary feature of Excel is the ability to	
  

	
  easily perform many mathema:cal and	
  
	
  sta:s:cal calcula:ons through func:ons and	
  
	
  formulas.	
  

•  A func:on is a formula pre-­‐established by	
  
	
  Excel	
  

•  A formula is created by the Excel user as	
  
	
  needed	
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Tutorial 2 FuncAons and Formulas XP 

•  The following formulas will be calculated in	
  
	
  Tutorial 2	
  
	
   	
  – Sales—the total amount of sales at all of the	
  
	
   	
   	
  restaurants	
  

	
   	
  – Cost of Sales—the cost of producing the store’s	
  
	
   	
   	
  menu items	
  

	
   	
  – OperaAng Expenses—the cost of running the	
  
	
   	
   	
  stores including the employment and insurance	
  
	
   	
   	
  costs	
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Tutorial 2 FuncAons and Formulas XP 

•  The following addiAonal formulas will also be	
  
	
  calculated in Tutorial 2	
  
	
   	
  – Net Profit/Loss—the difference between the	
  
	
   	
   	
  income from the gross sales and the total cost of	
  
	
   	
   	
  sales and opera:ng expenses	
  
	
   	
  – Units Sold—the total number of menu items sold	
  
	
   	
   	
  by the company during the year	
  
	
   	
  – Customers Served—the total number of	
  
	
   	
   	
  customers served by the company during the year	
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XP Forma4ng Numbers	
  
•  Goal: Make workbook easier to interpret	
  

	
  –Change the number of digits displayed to	
  
	
   	
  the right of the decimal point	
  
	
  –Add a comma as a thousands separator	
  
	
  –Control number of decimal places	
  
	
  –Use percentage and currency symbols	
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XP Forma4ng Calculated Values	
  
•  Create formulas to add, subtract, and divide	
  

	
  values	
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XP Forma4ng Calculated Values	
  

	
  •   Applying number formats	
  
	
   	
  – Use General number format for simple	
  
	
   	
   	
  calcula:ons	
  

	
   	
  – Apply Excel’s addi:onal formaEng to make	
  
	
   	
   	
  numbers easier to interpret	
  
	
   	
   	
   	
  • Accoun:ng style	
  
	
   	
   	
   	
   	
  –Lines up currency values within a column by	
  
	
   	
   	
   	
   	
   	
  currency symbol and decimal point	
  
	
   	
   	
   	
   	
  –Encloses nega:ve numbers within	
  
	
   	
   	
   	
   	
   	
  parentheses	
  

New PerspecAves on MicrosoD Excel 2013	
  
21	
  



XP Applying Number Formats	
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XP Applying Number Formats	
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XP Forma4ng Calculated Values	
  
•   FormaEng dates and :mes	
  

	
  – Dates/:mes are stored as numbers, not as text	
  
	
   	
  • Applying different formats does not affect	
  
	
   	
   	
  values	
  

	
   	
  • Makes it easier to calculate :me intervals	
  
	
  – Short Date format or Long Date format	
  

	
  – 12-­‐ or 24-­‐hour :me	
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XP Forma4ng Dates and Times	
  

	
  •  Excel provides many formats for dates and	
  
	
   	
  :mes in the worksheets depending on user	
  
	
   	
  requirements	
  
	
   	
   	
  – Select the cell in which the date and :me should	
  
	
   	
   	
   	
  appear	
  

	
   	
   	
  – On the ribbon, select the HOME tab	
  
	
   	
   	
  – In the Number group, click the Number Format	
  
	
   	
   	
   	
  buPon arrow to display a list of number formats,	
  
	
   	
   	
   	
  and then select the preferred format.	
  

	
   	
   	
  – The date is displayed with the selected format	
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XP Forma4ng Worksheet Cells	
  
•  Format appearance of individual cells by:	
  

	
  –Modifying alignment of text within the cell	
  
	
  –Inden:ng cell text	
  
	
  –Adding borders of different styles and colors	
  
	
   	
  to individual cells or ranges	
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XP Forma4ng Worksheet Cells	
  
•   Aligning cell content	
  

	
  – Default:	
  
	
   	
   	
  • Cell text aligned with	
  
	
   	
   	
   	
  lea boPom borders	
  
	
   	
   	
  • Cell values aligned	
  
	
   	
   	
   	
  with right	
  
	
   	
   	
   	
  boPom borders	
  
	
  – BuPons to set	
  
	
   	
  alignment op:ons are	
  
	
   	
  in Alignment group	
  
	
   	
  on Home tab	
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XP Forma4ng Worksheet Cells	
  
•  Inden:ng cell content	
  

	
  –Useful for entries considered subsec:ons of	
  
	
   	
  a worksheet	
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XP Forma4ng Worksheet Cells	
  
•  Merging cells	
  

	
  –Retains only content (and cell reference)	
  
	
   	
  from upper-­‐lea cell in the range	
  
	
  –Merge op:ons: Merge & Center, Merge	
  
	
   	
  Across, Merge Cell, and Unmerge Cells	
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XP Forma4ng Worksheet Cells	
  
•  Rota:ng cell contents saves space and	
  

	
  provides visual interest	
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XP Forma4ng Worksheet Cells	
  

	
  •  Adding cell borders enhances readability of	
  
	
   	
  rows and columns or data	
  
	
   	
   	
  –Add borders to lea, top, right, or boPom of	
  
	
   	
   	
   	
  cell or range; around an en:re cell; or	
  
	
   	
   	
   	
  around outside	
  
	
   	
   	
   	
  edges of a range	
  
	
   	
   	
  –Specify thickness	
  
	
   	
   	
   	
  and number of	
  
	
   	
   	
   	
  lines in border	
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XP Format Cells Dialog Box OpAons	
  

	
  •  Presents formats available from Home tab in a	
  
	
   	
  different way and provides more choices	
  
	
  •  Six tabs, each focusing on different op:ons:	
  
	
   	
   	
  –Number	
  

	
   	
   	
  –Alignment	
  

	
   	
   	
  –Font	
  
	
   	
   	
  –Border	
  
	
   	
   	
  –Fill	
  
	
   	
   	
  –Protec:on	
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XP OpAons in the Format Cells Dialog Box	
  
•  Border tab	
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XP Session 2.2 Visual Overview	
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XP Using the Average FuncAon	
  
•  As men:oned previously, Excel includes pre-­‐	
  

	
  determined formulas called func:ons.	
  
•  The AVERAGE funcAon calculates the average	
  

	
  value from a collec:on of numbers.	
  
	
   	
  – The syntax of the Average func:on is:	
  
	
   	
   	
  AVERAGE (number1, number2, number3, …)	
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XP Using the Average FuncAon	
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XP Applying Cell Styles	
  

	
  •  Use styles to ensure that cells displaying same	
  
	
   	
  type of data use the same format	
  
	
  •  Style	
  
	
   	
   	
  –Selec:on of formaEng op:ons using a	
  
	
   	
   	
   	
  specific font and color from the current	
  
	
   	
   	
   	
  theme	
  
	
   	
   	
  –If style is later revised, appearance of any	
  
	
   	
   	
   	
  cell formaPed with that style is updated	
  
	
   	
   	
   	
  automa:cally; saves :me and effort	
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XP Applying Cell Styles	
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XP Copying and PasAng Formats	
  

•  Copying formats with Format Painter	
  
	
  –Fast and efficient way of maintaining a	
  
	
   	
  consistent look and feel throughout a	
  
	
   	
  workbook	
  
	
  –Copies formaEng without duplica:ng data	
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XP Copying and PasAng Formats	
  

•  Use Paste Op:ons BuPon to paste formaEng	
  
	
  from a copied range along with its contents	
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XP Copying and PasAng Formats	
  
•  Use Paste Special to control exactly how to	
  

	
  paste the copied range	
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XP Finding and Replacing Text	
  

•  The Find and Replace commands let you make	
  
	
  content and design changes to a Worksheet or	
  
	
  the en:re workbook quickly.	
  

•  The Find command searches through the	
  
	
  current worksheet or workbook for the	
  
	
  content or formaEng you want to locate	
  

•  The Replace command then subs:tutes it with	
  
	
  the new content or formaEng you specify.	
  

New PerspecAves on MicrosoD Excel 2013	
   42	
  



XP Finding and Replacing Text	
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XP Working with Themes	
  

•  Appearance of fonts, colors, and cell styles	
  
	
  depends on workbook’s current theme	
  

•  If theme is changed, formaEng of fonts,	
  
	
  colors, and cell styles changes throughout	
  
	
  en:re workbook	
  

•  Only elements directly :ed to a theme change	
  
	
  when you select a different theme	
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XP Working with Themes	
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XP HighlighAng Cells with CondiAonal	
  
Formats	
  
•  Goal of highligh:ng: Provide strong visual clue	
  

	
  of important data or results	
  
•  Format applied to a cell depends upon value	
  

	
  or content of the cell	
  
•  Dynamic: If cell’s value changes, cell’s format	
  

	
  also changes as needed	
  
•  Excel has four condi:onal formats: data bars,	
  

	
  highligh:ng, color scales, and icon sets	
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XP HighlighAng Rules	
  
•  Each condi:onal format has a set of rules that	
  

	
  define how formaEng should be applied and	
  
	
  under what condi:ons format will be changed	
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XP HighlighAng Cells with CondiAonal	
  
Formats	
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XP HighlighAng Cells with CondiAonal	
  
Formats	
  
•  Always include a legend – a key that shows	
  

	
  each color used in the worksheet and what it	
  
	
  means	
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  XP 

•  Print op:ons can be applied to an en:re	
  
	
  workbook or to individual sheets	
  

•  Look at a worksheet in Page Layout view to	
  
	
  see how it would print	
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Forma4ng the Worksheet for PrinAng	
  	
   	
   	
   	
   	
  XP 

	
  •  Defining the print area allows you to override	
  
	
   	
  default seEngs and print part of a worksheet	
  
	
   	
   	
  –Region sent to the printer from the ac:ve	
  
	
   	
   	
   	
  sheet	
  
	
   	
   	
  –Can cover adjacent or nonadjacent range in	
  
	
   	
   	
   	
  current worksheet	
  
	
   	
   	
  –Generally easiest to set in Page Break	
  
	
   	
   	
   	
  Preview	
  
	
  •  Fit a large worksheet on a single page by	
  
	
   	
  reducing size of the page margin	
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  XP 

•  Inser:ng page breaks	
  
	
  – AutomaAc page breaks	
  
	
  – Manual page breaks	
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  XP 

•  Add print :tles (descrip:ve informa:on) on	
  
	
  each page of a printout in case pages become	
  
	
  separated	
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  XP 

•  Create page headers and footers to include	
  
	
  text not usually found within the worksheet	
  
	
  (e.g., author, date, filename)	
  

•  Headers and footers have three sec:ons: lea,	
  
	
  center, right	
  

•  Elements are dynamic	
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